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SUMMARY 

MINERVA (Modality-Inclusive Environment for Radiotherapeutic Variable 
Analysis) is a Java-based patient-centric radiation treatment planning system 
(RTPS) for computational dosimetry and treatment planning in emerging areas of 
radiotherapy for cancer and other diseases. MINERVA was primarily developed 
at the Idaho National Laboratory (INL) and Montana State University (MSU). 
MINERVA allows the radiotherapist to make side-by-side comparison of plans 
for multiple treatment modalities with a common anatomical basis for the 
computational geometry, calculate doses for combinations of different 
radiotherapy modalities, and perform dose analysis and reporting functions. This 
provides the therapist with a consistent basis for selecting the modality or 
combination of modalities to use for treatment of the patient. 

 

MINERVA employs an integrated, lightweight plug-in architecture to 
accommodate multi-modal treatment planning using standard interface 
components. The MINERVA design facilitates integration of improved or 
emerging treatment planning technologies. 

 

MINERVA consists of the basic radiation treatment planning software modules 
managed by a consistent patient interface for developing multi-modal 
radiotherapy patient treatment plans. One of MINERVA's main functions is to 
provide a graphical environment for constructing and displaying uniform 
volume-element-based solid models derived from medical images. These solid 
models form the geometric basis of the target areas for the radiation transport 
model. 
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1. INTRODUCTION 

MINERVA is a Java-based patient-centric radiation treatment planning system (RTPS) which can be used 
for planning and analyzing several radiotherapy modalities, either singly or combined, using common 
modality independent image and geometry construction and dose reporting and guiding. An example of 
combined planning would be an IMRT external beam treatment with a brachytherapy boost. 
 
MINERVA is being developed with the Java Virtual Machine for interoperability. MINERVA employs 
an integrated, lightweight plug-in architecture to accommodate multi-modal treatment planning using 
standard interface components. The MINERVA design also facilitates the future integration of improved 
planning technologies. 
 
As shown in the upper half of Figure 1, the MINERVA design includes the three common software 
modules used by any RTPS, along with a central patient module to coordinate communication and data 
transfer. The source and transport plug-in modules, shown on the left and bottom of Figure 1, 
communicate with these modules either directly through the patient database or through MINERVA’s 
extensible markup language (XML)-based application programmer’s interface (API). All internal data is 
managed by the database management system (DBMS) and can be exported to other applications or new 
installations through the API data formats. 
 

 
 

Figure 1. Basic design of the MINERVA treatment planning system. Dashed boxes represent future (to be 
developed) plug-in modules. 
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In typical use, MINERVA consists of three main components:  
 

• Manual and semi-automated geometric modeling of organs and physical structures derived from 
MRI, CT, and other medical imaging modalities; 

• Dose computation for these geometric models with the appropriate radiation transport computer 
code; 

• Dose reporting and combination to determine dose distribution and dose-volume histograms. 
 
Digitized data produced from medical imaging devices are used as a template to draw, fill, paint, or 
automatically construct regions of interest in each image plane, forming a solid model description of the 
region of interest. These solid model descriptions are composed of rectangular parallelepipeds of uniform 
size, each uniquely mapped to a single organ or physical structure.  The rectangular parallelepipeds are 
referred to as uniform volume elements (univels). Because of the uniformity of the univels, geometric 
interrogation can be performed using a very efficient integer arithmetic algorithm. Also, the resolution of 
the univels is only limited by the imaging modality, since each univel can be as small as an individual 
image pixel. 
 
Using the solid model descriptions of the regions of interest, a three-dimensional radiation 
transport calculation determines the radiation fields present for a particular treatment modality. 
These radiation fields are then related to radiation doses delivered to the treatment volume and 
surrounding areas. 
 
When the planning calculations are complete, the radiation fields are displayed either as dose 
contours in the original image space, dose volume histograms, or dose-depth plots. This gives the 
clinician or researcher an accurate and convenient way to view the radiation fields, so that the 
modality and dose delivery parameters can be quickly determined, balancing tumor cell kill 
against healthy tissue sparing. 
 
The remainder of this manual provides a guide to the practical use of MINERVA’s basic 
modules, but is not an exhaustive treatment of each feature of the code. 
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2. CONCEPTS AND NOTIONS 

The basic concepts used by MINERVA are image slices and regions, as illustrated in Figure 2. An image 
slice is data corresponding to a single medical image. Typically, several anatomical features of interest 
will intersect an image slice. For example, an image slice can contain a cranial object, tumor object, and 
objects defining eyes, sinuses, and other relevant features.  

  

Figure 2. Basic MINERVA Concepts 

Regions are defined by segmenting the data in a set of image slices. Once defined, region definitions in 
different slices are combined to form three-dimensional volumes. 
 
Typically, the user begins by displaying an image slice, and then defining regions on that image. After 
several regions have been defined, they may be reconstructed (or synthesized) into a three dimensional 
object representing a structural or functional feature. These reconstructions can be displayed in a three-
dimensional viewing window, where viewing controls allow arbitrary views of the reconstructed data. 
 
The univel, or Uniform Volume Element, geometry (Frandsen 1998, Frandsen 2001) is fundamental to 
the MINERVA geometry description. A univel is essentially a three-dimensional image pixel with 
uniform slice spacing between image slices. This representation gives significant computational 
advantages for Monte Carlo transport dose calculation and simplifies the description and display of the 
data. Note that the image data used for segmentation must have a uniform spacing between slices; if 
imported image data does not have uniform slice spacing; tools are provided to re-slice the image data to 
achieve this uniform spacing. 
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3. DATA MANAGEMENTS 

MINERVA's data management system employs an interface layer to provide a framework for modules to 
communicate with the data sources. As a result, the data sources are loosely coupled to the rest of the 
MINERVA. This allows new data storage technologies to be added without cascading effects throughout 
the system. Although not every module accesses all of the data sources, the data interface layer gives 
them the ability to do so, if needed. 
 
Currently, MINERVA supports two types of data storage, relational databases and XML files. When 
MINERVA is first invoked, the Patient module will create the data interface layer, which can be utilized 
by the Image, Model, and Analyze modules. When data is required from a data source, a module issues a 
request to the data interface layer with a unique data identifier and the data source to examine. Once the 
data is retrieved, it will be cached in memory or on disk if memory availability is low. Subsequent 
requests for that data will retrieve the data out of the fastest cache available, thus improving the system's 
response time. 
 
3.1 Database 
 
All patient data is stored in a relational database, removing the burden of tracking multiple patient files 
from the user. The Java Database Connectivity (JDBC) technology allows MINERVA to communicate 
with almost any database that has a JDBC driver available for it. 
 
The Patient, Image, Model, and Analyze modules have working database access. The database connection 
is established as part of the data interface layer setup by the Patient module. 
 
Steps have been taken to ensure that the database integrity is maintained by using database transactions 
and foreign key constraints. Database transactions allow MINERVA to revert to a previous state if there 
was an error while saving an object, keeping the database from becoming corrupted. The foreign key 
constraints prevent MINERVA from removing items from the database until all references to the item 
have been removed, preventing accidental partial deletion of items. 
 
3.2 File Import/Export Features 
 
Because database files are generally hidden from the user and not easily transportable, a convenient way 
to transfer patient information between various users and installations was developed. To accomplish this, 
a complete Extensible Markup Language (XML) file specification of all of the information contained in 
the database and a set of XML-based import/export tools are being developed. This same XML file 
specification will also be used to help define the API between MINERVA and the various source and 
transport plugin modules. 
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Figure 3.  Data management scheme for MINERVA. 

 
The XML-based tools allow any module that has access to the data interface layer to perform the 
following functions:  
 
1. import external patient XML files directly into the database; 
2. import XML files generated by an external plugin; 
3. export specific data needed by an external plugin to perform an operation; 
4. export all or part of a patient's data. 
 
Tools 1 and 4 can be used to transport a patient or partial patient from one installation to another, or to 
backup a patient's data in a form not specific to any database vendor. Tools 2 and 3 allow external plugins 
to acquire information from, and provide information to, the MINERVA system. 
 
The user can directly access the XML import/export features from the Patient module's toolbar, as shown 
in Figure 4. The menu options activate or deactivate situationally based on previous user actions. The user 
may export an entire patient, or export only the data of interest. The import command may import an 
entire XML document into the database, or only import a subsection of the XML document. Dependency 
checking will be done to maintain the integrity of the database. Other modules have access to XML 
functionality, should they need to use it. 
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Figure 4. XML import/export menu in the Patient module. 
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4. THE PRIMARY MINERVA MODULES 

The Patient, Image, Model, and Analyze modules of the MINERVA system are summarized in the 
following sections. 
 
4.1  Patient Module 
 
The Patient module, which is the entry point to, and the hub of, the MINERVA system, manages the 
entire treatment planning process. In addition to launching and managing the Image, Model, and Analyze 
modules, the Patient module creates, edits, and retrieves data from the patient database. 
 
The Patient module user interface allows the user to record, review, and edit patient information. A screen 
shot of the user interface is shown in Figure 5. This information includes some standard fields (name, 
address, phone, e-mail, date of birth, gender, etc.), but also includes user-specified fields. The Patient 
module allows the user to see what other data is associated with a given patient. 
 

 

Figure 5. Patient module user interface. 
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The Patient module controls MINERVA by launching the other modules, managing memory and data, 
allowing the user to view and modify preferences for the software's behavior and appearance, and 
maintaining a list of the most recently used patient data. 
 
The Patient module is able to open a robust connection to the patient database using a Java Database 
Connectivity (JDBC) compliant database engine. Thus far, it has been tested using the MySQL (Widenius 
and Axmark 2002), PostgreSQL, and Derby database systems. A complete user interface is provided so 
that the planner can easily create, edit, or retrieve the patient data. If the Patient module is unable to 
complete the database connection, the program can still run and provide diagnostics to the user. 
 

  
 

Figure 6. Image module user interface. 

Patient information may be imported to, or exported from, the patient database using the XML-based API 
data formats. 
 
4.2  Image Module 
 
The Image module prepares and processes individual images and complete image sets for use by 
subsequent analysis modules. 
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The user interface for the Image module is shown in Figure 6. Full database connectivity is included in 
the Image module. The Image module currently supports QSH, grayscale JPEG, grayscale PNG, and raw 
image import functions and partially supports DICOM-RT. With appropriate plugins, the Image module 
can convert other image formats to the internal MINERVA image format and store this data in the patient 
database. Plugin support allows additional image manipulation operations and import filters to be added 
at a later date. Standard image processing features, including noise filtering, gamma correction, and 
contrast enhancement, are provided. 
 
A rigid body registration system based on maximization of mutual information (Viola and Wells 1997) 
has been included, with a three-dimensional display of the image registration process (see Figure 7). To 
facilitate the registration and define the geometry, a reslicing tool has been developed. This tool performs 
a pixel-by-pixel interpolation between existing image slices to define new images and create a uniform 
spacing between image slices, if one does not already exist in the original image set. 
 

  

 

Figure 7. Image module registration process. 
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4.3  Model Module 
 
The Model module creates the anatomical geometry of the patient and target based on the image data 
received from the Image module. The Model module can be used to either create a new univel geometry 
file or edit an existing model. Anatomical structures are defined by various methods, and materials are 
assigned to these regions. The univel geometry permits very fast Monte Carlo analysis. The user interface 
and some of the features of the Model module are shown in Figure 8. 
 

  
 

Figure 8. Model module user interface. 

The Model module contains several methods for manually or semi-automatically defining up to 32,768 
regions of interest (ROIs) from one or more image sets, which may encompass several imaging 
modalities. A great deal of effort was expended to make manual ROI definition easy and fast, as an 
interim solution until a suitable and robust automated procedure can be developed. All of the tools and 
operations have been implemented as plugins to simplify the program design and to allow the later 
addition of more advanced tools. A generic undo manager will record the user’s actions, and allow them 
to be reversed. All modeling can be conducted with multiple image sets along the three principal 
orthogonal axes simultaneously and interchangeably. Multiple image sets may be used simultaneously to 
define the ROIs. 
 
Zooming support is included, and the display of image slices is optimized for speed and memory usage. A 
3D visualization view, shown in Figure 9, can be used to display the current geometry and will update as 
the user constructs the geometry to give interactive feedback. 
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Figure 9. Model module univel surface rendering plugin. 

The Model module also supports scripting, where significant user actions are recorded to a file that can be 
played back later. Either an entire or partial modeling session can be recorded, giving the user the ability 
to automate common tasks. With this feature, modeling sessions can be replicated easily or stored as 
planning templates. This has the capability of validating and simplifying the modeling process. 
 
4.4 Analyze Module 
 
Control of plan development and dose reporting is consolidated in the Analyze module. The planning 
function controls the launching of the source and transport plugins, receives the results from these plugin 
modules, and saves the results to the database. The dose reporting function accesses the database to read 
the dose information for each field in the plan, and performs the dose combination and reporting. An 
example of the Analyze module capabilities is shown in Figure 10. 
 
The Analyze module planning control, shown in the upper (tabbed) section of Figure 10, can create 
multiple strategies, plans, and fields, and can combine fields into plans and plans into strategies. For the 
MINERVA system, a field is defined as a single radiation application, a plan is a single radiation therapy 
modality application, and a strategy is a set of plans administered to a patient. Basic checks are executed 
before inserting a field or a plan, such as checking the dimensions and modality types to assure 
consistency. The Analyze module launches source plugins to create the radiation source descriptions for 
each field, and transport plugins to calculate the dose distribution. (The dose data are included in the 
MINERVA field definition.) A default transport plugin was created to export the field information, with 
its associated source and geometry, to an XML file and import calculated dose data from an XML file and 
associate it with the field. 
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Figure 10. Analyze module user interface. 

The Analyze module merges the dose data from multiple fields into one dose data object for a plan, and 
multiple plans are merged into a strategy. This merger can be customized by allowing the user to set 
modality-dependent biological weighting factors by field, region, and dose component. Binary agents, 
radioprotectants, and radiosensitizers may be included for each field, with the effects included in the 
merging process. 
 
Analyze uses a plugin system to display the dose data to the user. This allows the user to customize the 
program by adding additional display plugins. The standard plugins calculate and display dose contours, 
dose volume histograms, and dose-depth charts. The dose volume histogram plugin itself uses plugins to 
generate the data and users will be able to implement their own algorithms for these functions. 
 
The contour plugin will display the dose data as contours drawn on top of an image set, as shown in 
Figure 11, on all three principal axes. These contours will automatically update in the background as the 
user changes the weighting values (biological weight factors, binary agent concentrations, etc.) for 
interactive feedback. The user also has the ability to print and export the contours as an image file. 
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Figure 11. Analyze module dose contour display. 

The dose volume histogram (DVH) plugin displays the dose information based on the chosen graph type, 
as shown in Figure 12. It currently supports several different plot types, including plugins for cumulative, 
frequency, and volume graphs. The dose-depth plugin will display dose information on a chosen line 
segment through a 3D region. Both plugins have automatic updates as the user changes weighting values. 
The user is able to print, export, or save plots to the database for future use. 
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Figure 12. Analyze module DVH display. 
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5. INSTALLATION INSTRUCTIONS 

Before installing MINERVA, an ODBC/JDBC compliant database system must be installed. Instructions 
for setting up MySQL are given in Appendix A and instructions for PostgreSQL are given in Appendix B; 
to install other database systems, follow the instructions provided with the database software. MINERVA 
is distributed to the typical user as either an exe file for Windows users or a bin file for Linux, Solaris, or 
MacOS X users. After running or executing this file as is normal for your operating system, the wizard 
window shown in Figure 13 should appear. Simply follow the instructions and the run time version of 
MINERVA will be installed on your system. Appendix C provides a list of additional software that must 
be installed for proper MINERVA operation; these packages should be installed before attempting to 
install MINERVA. 
 

 
 

Figure 13. MINERVA installation wizard window. 
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6. MINERVA OPERATIONAL GUIDE 

It is not the intent of this section to exhaustively cover every possible selection in the various modules; 
that would be overly detailed and burdensome, and that function has been delegated to the MINERVA 
help system. Rather, the aim of this section is to provide an overview of the basic functionality needed by 
the user to start the various modules and access the help menu for further operational detail. 
 
6.1  MINERVA Help System 
 
As a supplement to the information provided in this manual, a help system has been developed for 
MINERVA. This system provides a help information facility that allows users to navigate, search, and 
display help information, as shown in Figure 14. It can also help new users learn how to use the 
MINERVA system, reducing the initial training time. 
 

  
 

Figure 14. The MINERVA help system. 

The help system has a table of contents displaying all the pages in a tree structure, an index, a glossary of 
terms, and a search function. Information for additional plugins can be added as needed, as can tutorials. 
The help system may be launched from any of the MINERVA modules or plugins. 
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6.2  Patient Module 
 
The Patient module provides access to the Image, Model, and Analyze modules and provides the interface 
layer to the patient database. This module can be launched from the command line or a desktop icon. 
Launching the Patient module should produce the display shown in Figure 15. 
 

  
 

Figure 15.  Patient module main interface. 

To open a patient in the Patient module, select Open from the File pull-down menu. If connection to a 
database has not been made, you will be prompted to do so, as shown in Figure 16. 
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Figure 16.  Interface prompting for database connection information. 

Once connected to a patient database, choose the patient from the list and click OK, as shown in Figure 
17.  
 

  
 

Figure 17.  Selection of a patient from the database. 

If opening a new patient choose New from the File menu and enter the new patient ID, as shown in Figure 
18. 
 

  
 

Figure 18.  Entering a new patient ID. 

If an existing patient ID is entered for a new patient, the Patient module will produce an error message. A 
new and unique patient ID must be provided for each patient. 
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The patient information may now be entered, via the panel shown in Figure 19. This includes normal and 
emergency contact information, physician information, and patient medical history. A photograph of the 
patient may also be provided, if desired. Navigation between data fields may use either the TAB key or 
the mouse. 
 

  
 

Figure 19.  Patient information panel. 

Importing and exporting data for a particular patient can be done from the Patient module. Data can be 
imported by using the option “Import New Patient” under the File→Import menu. This imports data for a 
new patient not currently in the selected database. Data may be added to an existing patient with the 
“Importing Into Current Patient” option, which can also be found under the File→Import menu. This 
operation imports particular data objects without having to import the entire patient. Exporting patient 
data can be done using the “Export Data” option located under the File→Export menu. This allows any 
particular subset of the patient's data to be exported. 
 
All XML import and export operations use a dependency checking system to ensure data integrity. For 
example, if the user were to try to import or export a 3D model, then the Patient module would also 
require importation of the images that were used to construct that model. In order to allow this in an 
intuitive manner, MINERVA supplies a visual tool that allows the user to see the dependencies in real 
time. If the user selects an object that has dependents, then the dependents will also be selected. There is 
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protection in place to prevent the user from unselecting any data object that is a dependent of another data 
object. If the user tries to unselect a dependent object, an error popup will be displayed (see Figure 20). 
 

  
 

Figure 20.  Export dialog and dependency error message. 

The Import dialog looks virtually the same as the Export dialog, except the Import dialog has a different 
header. This helps the user identify which window is open.  
 
6.3  Image Module 
 
The Image module is launched from the Patient module through either the Image Module icon on the 
toolbar or the Modules menu. As stated in section 3, the Image module can currently Import DICOM-
RT, QSH, JPEG, and raw image. Standard image processing features, including noise filtering, gamma 
correction, and contrast enhancement, are also provided. 
 
With the exception of the Register selection of the Tools menu, the help system should provide 
sufficient operational detail for the other Image module menu features. 
A rigid body registration system based on maximization of mutual information (Viola and Wells 1997) 
has been included, with a three-dimensional display of the image registration process (Figure 21). To 
facilitate the registration, and to define the univel geometry, a reslicing tool has been developed. This tool 
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performs a pixel-by-pixel interpolation between existing image slices to define new images and create a 
uniform spacing between image slices. This univel representation is the basis for the segmentation 
process in the Model module. 
 

  
 

Figure 21. Display from the MINERVA Image module, showing co-registration of MR and PET images. 

6.4  Model Module 
 
The Model module is used to segment an image set by defining organs and other structures using a variety 
of segmentation tools. This defines the patient geometry model used to perform dose calculations. 
 
The Model user interface is split into six main sections. The segmentation tools are displayed on the far 
left, with the currently active tool highlighted. These tools are provided by plugins, so this section of the 
display may look different depending on the plugins installed. To the right of the tools display is the main 
editing area. The currently selected tool is operable inside this area and any actions taken (mouse clicks, 
drags, etc.) are forwarded to the current tool. Farther to the right is a thumbnail display of the image 
slices. Clicking on a slice will place that slice in the editing area. The list of currently defined regions 
within the geometry is at the far right. (In MINERVA, a region denotes an organ or structure and the 
properties – composition, density, etc. – associated with it.) The view controls, including zooming, axis 
orientation, and opacity, are at the bottom center. The options available for the currently selected tool are 
displayed at the bottom right. These options will change depending on the selected tool. 
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Figure 22.  Model module user interface display. 

6.4.1  Editing 
 
While segmenting, it is important to remain aware of the current region and the status of the overwrite 
option for that region. The current region is the currently selected region in the regions list. The tools use 
the current region when performing their operations. The overwrite flag allows the user to protect some or 
all regions from being accidentally erased or overwritten. If the overwrite flag is turned off, then the 
univels with that region value cannot be modified. In order to erase or alter part of a region, that region’s 
overwrite flag must be set. 
 
6.4.2  Tools 
 
The segmentation tools along the left hand side of the window are used to define structures within the 
geometry. If the selected tool has any configuration options to control its behavior, then the controls are 
placed in the lower right of the Model display. 
 

  Paintbrush:  Paints the area under the mouse (drag) with the currently selected region. The 
brush size can be controlled and the middle and right mouse buttons can be defined to operate 
other tools. It is useful to define the middle button to use the Fill tool (Paint Bucket) and the right 
button the Eraser tool. In this way you could quickly outline an object, fill it, and make 
corrections by erasing. 

 
Paint Bucket:  Fills an enclosed area with the current region. Usually the paintbrush is used to 

outline a region and the paint bucket is used to fill the interior of the outline. The paint bucket can 
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also be used to change the region assigned to a segmented area. If the user clicks on a segmented 
area with a different region selected, then the area they clicked on will be replaced with the 
currently selected region. The paint bucket can work in 2D or 3D mode. In 2D mode the fill is 
constrained to the current slice. In 3D mode the tool will fill connected areas above and below the 
active slice. 

 

Eraser:  The eraser is the inverse of the paintbrush – it removes the region definition from 
the selected area under the mouse. This tool uses the same brush size as the paintbrush. 

 
  Wand:  The wand tool fills based on the image pixel intensity. The user selects a “seed 

pixel” that serves as the starting point for the wand function and defines a threshold for the pixel 
intensity search. The wand tool will expand the area around the seed pixel, in either 2D or 3D, to 
include pixels directly connected to the seed pixel that have intensity within half the threshold 
(plus or minus) of the seed pixel intensity. This expansion is continued recursively until either no 
additional pixels within the threshold are found or until a boundary, either a defined area with 
overwrite protection or the image boundary, is encountered. 

 
  Copy:  Allows the user to copy selected areas to a different slice. When the user clicks on a 

region in the image, the copy tool finds the boundary of that region and copies it to the clipboard. 
To select multiple areas hold down the shift key while selecting regions. A preview is displayed 
in the tool options area to show the clipboard contents. 

 
  Erode:  The erode tool will find the edges of the region the user clicked on and remove a 

specified amount from the edge of the region. The amount removed can be specified in pixels, 
centimeters, or millimeters. The erode tool can be constrained to work only in the current slice or 
to work in 3D. 

 
  Dilate:  The inverse of the Erode operation. Instead of deleting pixels at the edge of the 

region, the dilate tool adds pixels. Like the Erode tool, the amount added is user-defined and the 
tool can be configured to work in 3D. 

 
  Constraint Marker:  This tool allows the user to specify constraints on any point in the 

geometry or for any region. The constraints allow the user to specify limiting doses for that 
location or region. 

 
  Convergence Marker:  The convergence marker allows the user to specify locations in the 

geometry to be used to determine dose calculation convergence in the transport plugins. 
 

  Fiducial Marker:  The fiducial marker allows the user to mark points in the geometry for 
use in registration, alignment, or positioning. 

 
6.4.3  Operations 
 
Operations are commands that affect the entire geometry rather than just a single slice. 
 

Mode Fill:  This operation will search the geometry for unassigned pixels. For each unassigned 
pixel, it will find the region that has the most pixels surrounding it and assign that region value to 
the unassigned pixel. This is useful for catching the occasional stray pixel that was missed by a 
tool operation. 
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Thresholding:  The thresholding operation allows the user to isolate regions using pixel intensity 
thresholds. The threshold can apply to a slice or to the entire image set. It may also be applied to a 
subsection of a slice by clicking on the preview (see Figure 23) and the threshold operation will 
flood fill from that point, constrained by the threshold. To specify the threshold the user clicks 
and drags in the histogram area. The preview image will update to display the results of the 
thresholding operation. The user can modify the threshold definition by holding down a modifier 
key. A slider mode is also available to define the upper and lower threshold values. 

 
6.4.4 Loading Data From External Files 
 
The Model module provides two plugins which read geometry information from existing files. Under the 
File menu is a Import menu that lists all the current plugins for importing data.   The first plugin, labeled 
UVH on the menu selction reads univel geometry files, and the other plugin, labeled Dicom Geometry, 
has limited support for DICOM RT structure sets that have closed planar contours as long as the image 
set and the structure set are within the same plane. 
 

  
 

Figure 23.  The threshold operation display. 

6.5  Analyze Module 
 
The Analyze module has two principal functions:  create one or more treatment plans for a patient; and 
graphically display and compare the dose data from these various treatment plans. The Analyze module 
display window has a specific work area for each of these functions – the upper section is used to define 
treatment plans and the lower section displays the dose data. 
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Figure 24.  Analyze module interface display. 

6.5.1  Definitions 
 
The following terms need to be defined to allow a clear and consistent explanation of the Analyze module 
functions. 
 

Field:  A field is the base data object. It represents a single source of radiation, and the effects of 
that radiation dose. Fields are used to build plans, which are then used to build strategies. A field 
may exist in more then one plan, so any changes to one field may affect multiple plans and 
multiple strategies. 

 
Plan:  A plan corresponds to a full treatment course with a single irradiation modality. A plan 
may be constructed from multiple fields, with the constraint that all the fields have the same 
coordinates (image sets are co-registered) and the same modality as the plan. Fields within a plan 
can be weighted to change the effect of a single field. A single plan can be inserted into multiple 
strategies. If a plan exists in multiple strategies, then all associated strategies will be changed if 
the plan is changed. 

 
Strategy:  A strategy is a complete treatment plan for a patient. It consists of multiple plans that 
may contain multiple fields, with the constraint that all plans in the strategy must have the same 
coordinates. Plans of different modalities can be added to the same strategy. Multiple strategies 
can be made and the user can compare the effects of the different strategies by evaluating the 
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resulting dose data. Once a course of action is determined, the strategy to be administered can be 
locked to prevent any changes. This locked strategy is defined as the treatment. 

 
Source Editor:  Each field is associated with a single radiation source. The source editor is used 
to define the radiation source for the field. 

 
Transport Editor:  Each field requires a dose calculation. The transport editor takes the field 
definition (geometry, source, etc.), simulates the radiation transport through the geometry, and 
returns a data object containing the results of the simulation, i.e., the dose. 

 
6.5.2  Analyze Workflow 
 
The Analyze module has a specific workflow. First a strategy is created, and then plans and fields are 
added to it. The various source and transport editors are used to run the radiation simulations. Then, the 
user evaluates the strategies, plans, and fields using the dose display features. If a strategy/plan/field is 
found to be lacking, the user can go back, make changes, rerun the simulations, and revaluate the plots. 
This is done repeatedly until the user is satisfied with the results and can mark one strategy as the strategy 
used to treat the patient. This strategy will then become locked and the user will be prevented from 
changing it. 
 
6.5.3  Analyze Walkthrough 
 
This section describes the process for creating and adding strategies, plans, and fields. 
 
1) First, create a new strategy by clicking on the new strategy button in the toolbar, or by selecting “New 
Strategy” from the File menu (see Figure 25). 
 

 
 

Figure 25.  Display for creating a new strategy. 

2) Next, create a plan by clicking the add plan button or selecting “Add Plan” from the Edit menu, and 
then clicking the “Create New Plan” button (see Figure 26). The plan treatment modality then must be 
selected. After creating the plan, click OK to add the new plan to the current strategy. To add the same 
plan to another strategy, click the add plan button again and, rather than creating a new plan, select one of 
the plans available in the plan popup menu. 
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Figure 26.  Display for creating a new plan. 

3) Create a field by first making sure the plan created in the previous step is selected. Then click on the 
add field button or select “Add Field” from the Edit menu, and click the “Create New Field” button (see 
Figure 27). The add field button is context sensitive and will not be available unless a plan is selected. 
Create the field by giving it a name, the geometry to use, and specifying the modality, the source editor to 
use, and the transport editor. The geometry will define the coordinates for the field and Analyze will 
prevent addition of a field to a plan with different coordinates. Like the add plan command, the add field 
command will allow the same field to be used by multiple plans. 
 

  
 

Figure 27.  Display for creating a new field. 

4) Once the field has been created the source and transport editors must be run. To run the editors, click 
the button next to the status message supplied by the editors. Each modality will have a different source 
and transport editor; these are defined locally. 
5) As shown in Figure 28, the weight column for Field1 is highlighted in red. This is to alert you that the 
weights for that field do not sum to one. You will be prevented from plotting the results until the weights 
have been corrected. To edit the weight, double click on the desired weight value and enter the new value. 
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Figure 28.  Analyze display showing a strategy with one plan and one field. 

6) After the source and transport editors have run and the field weight values are set, the plotting features 
can be used to display and compare the dose data. 
 
6.5.4  Plotting 
 
In order to evaluate the effectiveness of a strategy/plan/field, the Analyze module includes three basic 
plotting engines. The Contours engine displays dose contours on top of an image set, Dose Depth traces a 
ray through the object’s coordinate system and displays the dose levels along that ray, and the DVH, or 
Dose Volume Histogram, engine charts the volumetric distribution of dose. Each plotting engine is 
provided by a plugin, so new plotting plugins can be added easily. 
 
The user can plot the results for an entire strategy, a plan, or just a field. There are some conditions that 
will prevent a plot from being generated. For example, if the transport editor has yet to be run for a field, 
then no plots for that field can be displayed. This cascades up the chain of objects, so a plan that contains 
an incomplete field cannot be displayed and the strategy containing that plan is also prevented from being 
displayed. 
 
In order to display a plot, the user just has to click on a field, a plan, or a strategy. If the user’s selection 
contains a valid dose, as described above, then it will be displayed in the current plotting mode. To switch 
between the different plotting modes, the user needs to select a different plot engine tab in the plotting 
area. As the user selects different objects the plots will update to reflect the user’s current selection. 
Sometimes there may be a delay while the dose information is being calculated. During these calculations 
a short message will be displayed in the upper left of the plots informing the user that MINERVA is busy 
calculating the dose information. 
 
6.5.4.1  Contours 
 
The Contours plotting engine displays dose contours on top of an image set. To display the contours, 
simply select the “Contours” tab in the plotting area, and click on a field, plan, or strategy containing 
valid dose information. The resulting display will resemble that shown in Figure 29. 
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Figure 29.  Dose contour display. 

Thumbnails of available slices are displayed on the right hand side, and the large image is displayed on 
the left with the contours drawn on it. The contours can be displayed on the thumbnail images by clicking 
the “Show Contours” button on the bottom of the screen. The Contour data can be displayed along any of 
the three principal coordinate axes by choosing the axis from the Axis popup menu at the bottom of the 
screen (see Figure 30). 
 

  
 

Figure 30.  Dose contour display along an alternate coordinate axis. 
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Various plot settings are available by clicking the “Edit Plot Properties” button (see Figure 31). These 
include configuring the ruler, displaying a grid, legend, adding labels, defining line styles, and specifying 
contour levels for display. 
     

 
 

Figure 31.  The Edit Plot Properties display for the contour plots. 

In addition to the standard line contours, the Contours plot can be configured to display the doses as a 
color wash instead of lines, as shown in Figure 32. Finally, the plots can be printed or exported to a 
graphic file. 
 

  
 

Figure 32.  Colorwash contour display. 

6.5.4.2  DVH 
 
The DVH plot displays information about how much dose a certain region received. To create a DVH 
plot, click on the “New Plot” button of the DVH panel. This brings up a panel to select which dose 
components and which regions to graph. Multiple dose components, or multiple regions can be selected, 
but there cannot be both multiple selected dose components and multiple selected regions. The user 
interface will prevent the user from selecting multiple elements from both types. Options are also 
available to specify the type of DVH plot (cumulative or differential). The different DVH calculation 
algorithms are implemented as plugins, so new algorithms can be added to the system easily. 
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Figure 33.  Colorwash contour display.Figure 33.  Colorwash contour display. 

After the wizard completes its operations, the plot will be displayed. In addition to the plot, a tabular 
summary of the DVH statistics is provided. 
 

  

Figure 34.  The DVH plot display. 
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Clicking on the “Edit Plot” button allows the user to re-define the data sources and modify the properties 
of the plot (line color, range, title, etc.). Like the Contours plot, the DVH plot allows you to print and 
export to a graphic file. 
 
In order to compare two or more fields, plans, or strategies, the current curves can be frozen. This causes 
the current curves to stay on the plot as the user selects different fields, plans, or strategies. The curves for 
the new selection will be displayed over the curves that have previously been frozen, allowing the user to 
compare the different data objects. 
 
6.5.4.3  Dose Depth 
 
The Dose Depth plot works by tracing a ray through the 3D geometry and displaying the dose data along 
the defined path. It also records what regions were traversed, allowing the user to see how the dose 
changes through the coordinate space. Creating a Dose Depth plot is similar to creating a DVH plot. 
Clicking the “New Plot” button on the Dose Depth panel launches the point selection panel and will ask 
for the starting and ending points of the ray to trace. 
 

  
 

Figure 35.  The dose depth plot panel. 

Once the user has entered the starting and ending points, the Dose Depth plot will be displayed. In 
addition to the graph of the dose levels, the regions the ray traversed is displayed as a vertical line at each 
region boundary. 
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Figure 36.  The dose depth plot display. 

Like the other plotting engines, the user can edit the data and plot properties by clicking on the “Edit Plot” 
button. Printing and exporting to a graphic file is also supported. 
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APPENDIX A-MYSQL SETUP 
HOW TO SETUP MYSQL FOR USE WITH TIRADE 
 
This appendix provides minimal instructions needed to set up the MySQL database software for use with 
the MINERVA system. It is not a complete guide for running and administering MySQL.  
 
The database needs to be setup on one computer at each site. After the database server is setup, each 
computer and MINERVA user only needs a user account on the server. To complete the installation, root 
access on the server system is required. 
 
1. Obtaining MySQL 
 
The MySQL database can be found at http://www.mysql.com. In the downloads section, select the latest 
stable production release. The next page will present you with the various MySQL system binaries. Find 
the appropriate system and download the "Standard" binaries. 
 
If you choose to download Linux RPMs you will also need to get the "Client programs" package as well. 
Versions of MySQL before 4.1 required the “max” version.  Mysql 4.1 and later include the needed 
features in the standard version, so the “max” version is not required. 
 
This example will assume installation on a Linux platform using RPM. For installation on a different 
platform or from a tar.gz file, please see the MySQL documentation for installation and configuration 
instructions. 
 
2. Installing MySQL 
Quick install instructions: 
 
1. su to root 
2. type 'rpm -ivh MySQL-server-version.platform.rpm  MySQL-client-version.platform.rpm' (using the 
full filename that includes the correct versions and platform ) 
 
3. Creating the Database 
First, set a password for root to prevent unauthorized access to your database. 
 
      $ /usr/bin/mysqladmin -u root password 'new-password' 
 
Then connect to the database 
 
      $ mysql -u root –p 
 
and create the database. 
 
      mysql> create database tirade; 
 
4. Adding users to MySQL 
Now add a user. 
 
      $ mysql -u root –p 
 



 

Appendix A-ii 

      mysql> grant all privileges on tirade.* to username@hostname identified by 'user-password'; 
 
The hostname is the name of the computer used to run MINERVA, not the server name. 
 
This can be repeated for any number of users by changing the hostname, username, and password. After 
all users have been added, type 'quit' to exit the mysql shell. 
 
5. Creating the MySQL configuration file 
The MySQL configuration file will be run when the MySQL server starts. Several tiers of my.cnf files 
can be setup, but for simplicity only the server specific file will be setup. If installing via RPM (as shown 
above), create the file /var/lib/mysql/my.cnf. If installing MySQL by a different method or in a different 
location, or to learn more about the my.cnf file, please see the MySQL documentation for more details. 
 
As root, open the my.cnf file in the specified location (it may be necessary to create the file if this is the 
first time anything has been added to it). There are two lines that must be added for MINERVA. A 
minimal configuration file should look like: 
 
     [mysqld] 
     max_allowed_packet=8M  
 
The first line lets MySQL know that this is a valid configuration file. The second line sets the max 
allowed packet size to 8 MB. This is needed because of the large binary objects will be stored in the 
database. After saving this file, perform the following commands as root: 
 
      # /etc/init.d/mysql restart 
      # mysqladmin variables | grep max_allowed_packet 
 
The second command should show the value for max_allowed_packet, which should output something 
like: 
 
      max_allowed_packet | 8387584 
 
Note: If the max_allowed_packet is not set correctly, MINERVA will likely fail when saving binary data. 
8 MB is not necessarily the smallest packet size possible, but during testing it has consistently worked. 
 
The new MySQL database is ready for use with MINERVA. For additional information on database 
security, please see the MySQL documentation.
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APPENDIX B-POSTGRESQL SETUP 
HOW TO SETUP POSTGRESQL FOR USE WITH TIRADE 
 
This appendix provides minimal instructions needed to set up the PostgreSQL database software for use 
with the MINERVA system. It is not a complete guide for running and administering PostgreSQL.  
 
The database needs to be setup on one computer at each site. After the database server is setup, each 
computer and user that uses MINERVA only needs a user account on the server. To complete the 
installation, database admin access on the server system is required. 
 
1. Obtaining PostgreSQL 
 
The PostgreSQL database can be found at http://www.postgresql.org . In the downloads section, select the 
latest stable production release. Most Linux and BSD distributions have PostgreSQL available in there 
package management system.  For Fedora, the command: 
yum install postgresql-server 
will install the PostgreSQL server on your computer. 
 
2. Post install of PostgreSQL  
Quick setup instructions: 
 
1. su to root 
2. Start the postgreSQL service.  Either a graphical service starting program such as serviceconf or the 
command line tools service and chkconfig can be used. 
 
3. Creating the Minerva Database 
Switch to the postgres user (or another use that has administrative privileges for the database) 
 # su postgres  
Then connect to the database 
 
      $ psql  
 
and create the database. 
 
      postgres=# create database minerva; 
 
4. Adding users to PostgreSQL 
Now add a user. 
 
 # su postgres 
 $ psql 
 
 postgres=#  create user fred with password 'password'; 
 postgres=#  create database fred; 
Note that with PostgreSQL and Minerva, a database with the user’s name must be created, otherwise 
Minerva will not be able to connect. 
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5. Allowing Remote access to the Database 
By default on Fedora PostgreSQL is not set up to allow remote access.  First, the firewall needs to let port 
5432 through.  Then in the directory /var/lib/pgsql/data the following configuration files need to be 
configured.  The pg_hba.conf file should have an entry to allow the user to connect from the remote file 
add a following line (with correct username and the ip address of the computer that they are connecting 
from substituted) for each user and computer that will connect: 
host    all         fred         192.168.123.45         md5 
The postgresql.conf needs to allow remote connections so add or edit the following lines: 
listen_addresses = '*'  
port = 5432 
This will allow the database to be accessed from a remote computer.
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APPENDIX C-ADDITIONAL PACKAGES FOR 
INSTALLATION 

ADDITIONAL PACKAGES NEEDED FOR MINERVA INSTALLATION 
 
In addition to the database software, several Java packages are necessary to properly install the 
MINERVA software system. All are available as free, publicly-distributed software packages; however, 
several have license restrictions on redistribution. Thus, each MINERVA user site will need to assure that 
these packages are installed on the local hardware before installing MINERVA. The following is a 
complete list of the necessary packages, along with the URLs to download each package: 
 
JOGL https://jogl.dev.java.net/ The July 12, 2005 1.1.1 version is required.  More recent JOGL 

versions will not work. 
JAI  http://java.sun.com/products/java-media/jai/index.jsp  
dcm4che http://sourceforge.net/projects/dcm4che/ (Included in installation) 
JDOM  http://www.jdom.org (Included in installation) 
JavaHelp http://java.sun.com/products/javahelp/download_binary.html (Included in installation) 
JUNIT  http://www.junit.org/index.htm Only required for compiling program. 
log4j  http://logging.apache.org/log4j/docs/ (Included in installation) 
Vecmath http://java.freehep.org/jcvslet/JCVSlet/log/freehep/freehep/tools/vecmath.jar/0 (Included 

in installation) 
Xerces  http://xerces.apache.org/xerces-j/ (Included in installation)  
In addition, the JDBC connector for the database will be required.  (PostgreSQL and Cloudscape 
connectors are included in installation.)  
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APPENDIX D-XML FILE WITH DOSESET 
EXAMPLE XML FILE WITH DOSESET 
 
his is an example xml file of a test patient that could be used as a guide for constructing the API between 
MINERVA and the transport plug-in.  Elements with a bin extension would be provided by the exporter. 
 
<?xml version="1.0" encoding="UTF-8"?> 
<minerva> 
  <patients> 
    <patient id="2007mar12test01"> 
      <dosesets> 
        <doseset id="field"> 
          <description /> 
          <nameGeneratedBy /> 
          <time /> 
          <versionGeneratedBy /> 
          <doseSetRBEs /> 
          <doseSetTissueToBlood /> 
          <doseSetBinaryAgents /> 
          <patientID>2007mar12test01</patientID> 
          <dataID>field</dataID> 
          <IS_length>53</IS_length> 
          <RL_length>512</RL_length> 
          <AP_length>512</AP_length> 
          <IS_mult>-0.5</IS_mult> 
          <RL_mult>0.08899999856948854</RL_mult> 
          <AP_mult>0.08899999856948854</AP_mult> 
          <IS_adder>36.5</IS_adder> 
          <RL_adder>-23.03999938964844</RL_adder> 
          <AP_adder>-25.73999938964844</AP_adder> 
          <sliceOrientation>AXIAL</sliceOrientation > 
          <dimensionality>CM</dimensionality> 
          <creationDate>2007-03-14T14:13:55Z</creat ionDate> 
          <modificationDate>2007-03-14T14:15:10Z</m odificationDate> 
          <doseComponentList> 
            <dosecomponent> 
              <scaleFactor>1.8788310785320574E-6</s caleFactor> 
              <parentID>field</parentID> 
              <patientID /> 
              <dataID>dose</dataID> 
              <IS_length>53</IS_length> 
              <RL_length>512</RL_length> 
              <AP_length>512</AP_length> 
              <IS_mult>-0.5</IS_mult> 
              <RL_mult>0.08899999856948854</RL_mult > 
              <AP_mult>0.08899999856948854</AP_mult > 
              <IS_adder>36.5</IS_adder> 
              <RL_adder>-23.03999938964844</RL_adde r> 
              <AP_adder>-25.73999938964844</AP_adde r> 
              <sliceOrientation>AXIAL</sliceOrienta tion> 
              <dimensionality>CM</dimensionality> 
              <creationDate>2007-03-14T14:13:55Z</c reationDate> 
              <modificationDate>2007-03-14T14:13:55 Z</modificationDate> 
              <slices> 
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                <slice>file_0.bin</slice> 
                <slice>file_1.bin</slice> 
                <slice>file_2.bin</slice> 
                <slice>file_3.bin</slice> 
                <slice>file_4.bin</slice> 
                <slice>file_5.bin</slice> 
                <slice>file_6.bin</slice> 
                <slice>file_7.bin</slice> 
                <slice>file_8.bin</slice> 
                <slice>file_9.bin</slice> 
                <slice>file_10.bin</slice> 
                <slice>file_11.bin</slice> 
                <slice>file_12.bin</slice> 
                <slice>file_13.bin</slice> 
                <slice>file_14.bin</slice> 
                <slice>file_15.bin</slice> 
                <slice>file_16.bin</slice> 
                <slice>file_17.bin</slice> 
                <slice>file_18.bin</slice> 
                <slice>file_19.bin</slice> 
                <slice>file_20.bin</slice> 
                <slice>file_21.bin</slice> 
                <slice>file_22.bin</slice> 
                <slice>file_23.bin</slice> 
                <slice>file_24.bin</slice> 
                <slice>file_25.bin</slice> 
                <slice>file_26.bin</slice> 
                <slice>file_27.bin</slice> 
                <slice>file_28.bin</slice> 
                <slice>file_29.bin</slice> 
                <slice>file_30.bin</slice> 
                <slice>file_31.bin</slice> 
                <slice>file_32.bin</slice> 
                <slice>file_33.bin</slice> 
                <slice>file_34.bin</slice> 
                <slice>file_35.bin</slice> 
                <slice>file_36.bin</slice> 
                <slice>file_37.bin</slice> 
                <slice>file_38.bin</slice> 
                <slice>file_39.bin</slice> 
                <slice>file_40.bin</slice> 
                <slice>file_41.bin</slice> 
                <slice>file_42.bin</slice> 
                <slice>file_43.bin</slice> 
                <slice>file_44.bin</slice> 
                <slice>file_45.bin</slice> 
                <slice>file_46.bin</slice> 
                <slice>file_47.bin</slice> 
                <slice>file_48.bin</slice> 
                <slice>file_49.bin</slice> 
                <slice>file_50.bin</slice> 
                <slice>file_51.bin</slice> 
                <slice>file_52.bin</slice> 
              </slices> 
            </dosecomponent> 
          </doseComponentList> 
        </doseset> 
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      </dosesets> 
      <univelscans> 
        <univelscan id="images"> 
          <modalitySpecificData /> 
          <scannerSetID /> 
          <imagingMachine /> 
          <description /> 
          <imageModality>CT</imageModality> 
          <colorTable>file_53.bin</colorTable> 
          <patientID>2007mar12test01</patientID> 
          <dataID>images</dataID> 
          <IS_length>53</IS_length> 
          <RL_length>512</RL_length> 
          <AP_length>512</AP_length> 
          <IS_mult>-0.5</IS_mult> 
          <RL_mult>0.08899999856948854</RL_mult> 
          <AP_mult>0.08899999856948854</AP_mult> 
          <IS_adder>36.5</IS_adder> 
          <RL_adder>-23.03999938964844</RL_adder> 
          <AP_adder>-25.73999938964844</AP_adder> 
          <sliceOrientation>AXIAL</sliceOrientation > 
          <dimensionality>CM</dimensionality> 
          <modificationDate>2007-03-14T14:15:11Z</m odificationDate> 
          <univelProperties> 
            <element key="levels-high">250.0</eleme nt> 
            <element key="levels-low">-250.0</eleme nt> 
            <element key="levels-center">0.0</eleme nt> 
          </univelProperties> 
          <slices> 
            <slice>file_54.bin</slice> 
            <slice>file_55.bin</slice> 
            <slice>file_56.bin</slice> 
            <slice>file_57.bin</slice> 
            <slice>file_58.bin</slice> 
            <slice>file_59.bin</slice> 
            <slice>file_60.bin</slice> 
            <slice>file_61.bin</slice> 
            <slice>file_62.bin</slice> 
            <slice>file_63.bin</slice> 
            <slice>file_64.bin</slice> 
            <slice>file_65.bin</slice> 
            <slice>file_66.bin</slice> 
            <slice>file_67.bin</slice> 
            <slice>file_68.bin</slice> 
            <slice>file_69.bin</slice> 
            <slice>file_70.bin</slice> 
            <slice>file_71.bin</slice> 
            <slice>file_72.bin</slice> 
            <slice>file_73.bin</slice> 
            <slice>file_74.bin</slice> 
            <slice>file_75.bin</slice> 
            <slice>file_76.bin</slice> 
            <slice>file_77.bin</slice> 
            <slice>file_78.bin</slice> 
            <slice>file_79.bin</slice> 
            <slice>file_80.bin</slice> 
            <slice>file_81.bin</slice> 
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            <slice>file_82.bin</slice> 
            <slice>file_83.bin</slice> 
            <slice>file_84.bin</slice> 
            <slice>file_85.bin</slice> 
            <slice>file_86.bin</slice> 
            <slice>file_87.bin</slice> 
            <slice>file_88.bin</slice> 
            <slice>file_89.bin</slice> 
            <slice>file_90.bin</slice> 
            <slice>file_91.bin</slice> 
            <slice>file_92.bin</slice> 
            <slice>file_93.bin</slice> 
            <slice>file_94.bin</slice> 
            <slice>file_95.bin</slice> 
            <slice>file_96.bin</slice> 
            <slice>file_97.bin</slice> 
            <slice>file_98.bin</slice> 
            <slice>file_99.bin</slice> 
            <slice>file_100.bin</slice> 
            <slice>file_101.bin</slice> 
            <slice>file_102.bin</slice> 
            <slice>file_103.bin</slice> 
            <slice>file_104.bin</slice> 
            <slice>file_105.bin</slice> 
            <slice>file_106.bin</slice> 
          </slices> 
        </univelscan> 
      </univelscans> 
      <geometries> 
        <geometry id="geometry"> 
          <patientID>2007mar12test01</patientID> 
          <dataID>geometry</dataID> 
          <IS_length>53</IS_length> 
          <RL_length>512</RL_length> 
          <AP_length>512</AP_length> 
          <IS_mult>-0.5</IS_mult> 
          <RL_mult>0.08899999856948854</RL_mult> 
          <AP_mult>0.08899999856948854</AP_mult> 
          <IS_adder>36.5</IS_adder> 
          <RL_adder>-23.03999938964844</RL_adder> 
          <AP_adder>-25.73999938964844</AP_adder> 
          <sliceOrientation>AXIAL</sliceOrientation > 
          <dimensionality>CM</dimensionality> 
          <creationDate>2007-03-12T13:17:52Z</creat ionDate> 
          <modificationDate>2007-03-14T14:15:15Z</m odificationDate> 
          <fiducialMarkerMap /> 
          <constraintMarkerMap /> 
          <regionConstraintMarkerMap /> 
          <convergenceMarkerMap /> 
          <body_info> 
            <bodyInfo key="0"> 
              <name>undefined</name> 
              <material_name>undefined</material_na me> 
              <uvval>0</uvval> 
              <c_red>0</c_red> 
              <c_green>0</c_green> 
              <c_blue>0</c_blue> 
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              <regionID>0</regionID> 
              <IS_lowerBounds>0.0</IS_lowerBounds> 
              <IS_upperBounds>0.0</IS_upperBounds> 
              <RL_lowerBounds>0.0</RL_lowerBounds> 
              <RL_upperBounds>0.0</RL_upperBounds> 
              <AP_lowerBounds>0.0</AP_lowerBounds> 
              <AP_upperBounds>0.0</AP_upperBounds> 
            </bodyInfo> 
            <bodyInfo key="1"> 
              <name>BLADDER</name> 
              <material_name>BLADDER</material_name > 
              <uvval>0</uvval> 
              <c_red>0</c_red> 
              <c_green>-1</c_green> 
              <c_blue>-1</c_blue> 
              <regionID>1</regionID> 
              <IS_lowerBounds>0.0</IS_lowerBounds> 
              <IS_upperBounds>0.0</IS_upperBounds> 
              <RL_lowerBounds>0.0</RL_lowerBounds> 
              <RL_upperBounds>0.0</RL_upperBounds> 
              <AP_lowerBounds>0.0</AP_lowerBounds> 
              <AP_upperBounds>0.0</AP_upperBounds> 
            </bodyInfo> 
            <bodyInfo key="2"> 
              <name>FEMUR_LEFT</name> 
              <material_name>FEMUR_LEFT</material_n ame> 
              <uvval>0</uvval> 
              <c_red>-1</c_red> 
              <c_green>0</c_green> 
              <c_blue>-1</c_blue> 
              <regionID>2</regionID> 
              <IS_lowerBounds>0.0</IS_lowerBounds> 
              <IS_upperBounds>0.0</IS_upperBounds> 
              <RL_lowerBounds>0.0</RL_lowerBounds> 
              <RL_upperBounds>0.0</RL_upperBounds> 
              <AP_lowerBounds>0.0</AP_lowerBounds> 
              <AP_upperBounds>0.0</AP_upperBounds> 
            </bodyInfo> 
            <bodyInfo key="3"> 
              <name>FEMUR_RIGHT</name> 
              <material_name>FEMUR_RIGHT</material_ name> 
              <uvval>0</uvval> 
              <c_red>-1</c_red> 
              <c_green>0</c_green> 
              <c_blue>-1</c_blue> 
              <regionID>3</regionID> 
              <IS_lowerBounds>0.0</IS_lowerBounds> 
              <IS_upperBounds>0.0</IS_upperBounds> 
              <RL_lowerBounds>0.0</RL_lowerBounds> 
              <RL_upperBounds>0.0</RL_upperBounds> 
              <AP_lowerBounds>0.0</AP_lowerBounds> 
              <AP_upperBounds>0.0</AP_upperBounds> 
            </bodyInfo> 
            <bodyInfo key="4"> 
              <name>GTV</name> 
              <material_name>GTV</material_name> 
              <uvval>0</uvval> 
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              <c_red>-1</c_red> 
              <c_green>0</c_green> 
              <c_blue>0</c_blue> 
              <regionID>4</regionID> 
              <IS_lowerBounds>0.0</IS_lowerBounds> 
              <IS_upperBounds>0.0</IS_upperBounds> 
              <RL_lowerBounds>0.0</RL_lowerBounds> 
              <RL_upperBounds>0.0</RL_upperBounds> 
              <AP_lowerBounds>0.0</AP_lowerBounds> 
              <AP_upperBounds>0.0</AP_upperBounds> 
            </bodyInfo> 
            <bodyInfo key="5"> 
              <name>PTVHD</name> 
              <material_name>PTVHD</material_name> 
              <uvval>0</uvval> 
              <c_red>-1</c_red> 
              <c_green>0</c_green> 
              <c_blue>0</c_blue> 
              <regionID>5</regionID> 
              <IS_lowerBounds>0.0</IS_lowerBounds> 
              <IS_upperBounds>0.0</IS_upperBounds> 
              <RL_lowerBounds>0.0</RL_lowerBounds> 
              <RL_upperBounds>0.0</RL_upperBounds> 
              <AP_lowerBounds>0.0</AP_lowerBounds> 
              <AP_upperBounds>0.0</AP_upperBounds> 
            </bodyInfo> 
            <bodyInfo key="6"> 
              <name>RECTUM</name> 
              <material_name>RECTUM</material_name>  
              <uvval>0</uvval> 
              <c_red>0</c_red> 
              <c_green>0</c_green> 
              <c_blue>-1</c_blue> 
              <regionID>6</regionID> 
              <IS_lowerBounds>0.0</IS_lowerBounds> 
              <IS_upperBounds>0.0</IS_upperBounds> 
              <RL_lowerBounds>0.0</RL_lowerBounds> 
              <RL_upperBounds>0.0</RL_upperBounds> 
              <AP_lowerBounds>0.0</AP_lowerBounds> 
              <AP_upperBounds>0.0</AP_upperBounds> 
            </bodyInfo> 
            <bodyInfo key="7"> 
              <name>SKIN</name> 
              <material_name>SKIN</material_name> 
              <uvval>0</uvval> 
              <c_red>0</c_red> 
              <c_green>-1</c_green> 
              <c_blue>0</c_blue> 
              <regionID>7</regionID> 
              <IS_lowerBounds>0.0</IS_lowerBounds> 
              <IS_upperBounds>0.0</IS_upperBounds> 
              <RL_lowerBounds>0.0</RL_lowerBounds> 
              <RL_upperBounds>0.0</RL_upperBounds> 
              <AP_lowerBounds>0.0</AP_lowerBounds> 
              <AP_upperBounds>0.0</AP_upperBounds> 
            </bodyInfo> 
          </body_info> 
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          <imagesets> 
            <element>images</element> 
          </imagesets> 
          <materialHash /> 
          <slices> 
            <slice>file_107.bin</slice> 
            <slice>file_108.bin</slice> 
            <slice>file_109.bin</slice> 
            <slice>file_110.bin</slice> 
            <slice>file_111.bin</slice> 
            <slice>file_112.bin</slice> 
            <slice>file_113.bin</slice> 
            <slice>file_114.bin</slice> 
            <slice>file_115.bin</slice> 
            <slice>file_116.bin</slice> 
            <slice>file_117.bin</slice> 
            <slice>file_118.bin</slice> 
            <slice>file_119.bin</slice> 
            <slice>file_120.bin</slice> 
            <slice>file_121.bin</slice> 
            <slice>file_122.bin</slice> 
            <slice>file_123.bin</slice> 
            <slice>file_124.bin</slice> 
            <slice>file_125.bin</slice> 
            <slice>file_126.bin</slice> 
            <slice>file_127.bin</slice> 
            <slice>file_128.bin</slice> 
            <slice>file_129.bin</slice> 
            <slice>file_130.bin</slice> 
            <slice>file_131.bin</slice> 
            <slice>file_132.bin</slice> 
            <slice>file_133.bin</slice> 
            <slice>file_134.bin</slice> 
            <slice>file_135.bin</slice> 
            <slice>file_136.bin</slice> 
            <slice>file_137.bin</slice> 
            <slice>file_138.bin</slice> 
            <slice>file_139.bin</slice> 
            <slice>file_140.bin</slice> 
            <slice>file_141.bin</slice> 
            <slice>file_142.bin</slice> 
            <slice>file_143.bin</slice> 
            <slice>file_144.bin</slice> 
            <slice>file_145.bin</slice> 
            <slice>file_146.bin</slice> 
            <slice>file_147.bin</slice> 
            <slice>file_148.bin</slice> 
            <slice>file_149.bin</slice> 
            <slice>file_150.bin</slice> 
            <slice>file_151.bin</slice> 
            <slice>file_152.bin</slice> 
            <slice>file_153.bin</slice> 
            <slice>file_154.bin</slice> 
            <slice>file_155.bin</slice> 
            <slice>file_156.bin</slice> 
            <slice>file_157.bin</slice> 
            <slice>file_158.bin</slice> 
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            <slice>file_159.bin</slice> 
          </slices> 
        </geometry> 
      </geometries> 
      <fields> 
        <field id="field"> 
          <patientID>2007mar12test01</patientID> 
          <dataID>field</dataID> 
          <sourceID /> 
          <geometryID>geometry</geometryID> 
          <description_string /> 
          <modality>External_Beam_P</modality> 
          <sourcePluginName>Null Source Editor</sou rcePluginName> 
          <transportPluginName>Default Transport</t ransportPluginName> 
          <doseID>field</doseID> 
          <sourceClassString /> 
          <locked>false</locked> 
          <sourceProperties /> 
          <transportProperties /> 
        </field> 
      </fields> 
      <patientData> 
        <dataID>2007mar12test01</dataID> 
        <patientID>2007mar12test01</patientID> 
        <physicianNotes /> 
        <patientInfo> 
          <homeEmail> 
            <value /> 
            <displayValue>Home Email</displayValue>  
          </homeEmail> 
          <sex> 
            <value /> 
            <displayValue>Sex</displayValue> 
          </sex> 
          <weight> 
            <value /> 
            <displayValue>Weight</displayValue> 
          </weight> 
          <emergencyContactInfo> 
            <value /> 
            <displayValue>Emergency Contact Info</d isplayValue> 
          </emergencyContactInfo> 
          <diagnosis> 
            <value /> 
            <displayValue>Diagnosis</displayValue> 
          </diagnosis> 
          <patientIDKey> 
            <value /> 
            <displayValue>Patient ID</displayValue>  
          </patientIDKey> 
          <referringPhysician> 
            <value /> 
            <displayValue>Referring Physician</disp layValue> 
          </referringPhysician> 
          <state> 
            <value /> 
            <displayValue>State</displayValue> 
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          </state> 
          <homePhone> 
            <value /> 
            <displayValue>Home Phone</displayValue>  
          </homePhone> 
          <workEmail> 
            <value /> 
            <displayValue>Work Email</displayValue>  
          </workEmail> 
          <treatmentProtocolID> 
            <value /> 
            <displayValue>Treatment Protocol ID</di splayValue> 
          </treatmentProtocolID> 
          <city> 
            <value /> 
            <displayValue>City</displayValue> 
          </city> 
          <postalCode> 
            <value /> 
            <displayValue>Zip</displayValue> 
          </postalCode> 
          <patientName> 
            <value /> 
            <displayValue>Patient Name</displayValu e> 
          </patientName> 
          <height> 
            <value /> 
            <displayValue>Height</displayValue> 
          </height> 
          <age> 
            <value /> 
            <displayValue>Age</displayValue> 
          </age> 
          <birthdate> 
            <value>Mon Mar 12 13:00:51 MDT 2007</va lue> 
            <displayValue>Birthdate</displayValue> 
          </birthdate> 
          <heightUnits> 
            <value>meters</value> 
            <displayValue>Height Units</displayValu e> 
          </heightUnits> 
          <workPhone> 
            <value /> 
            <displayValue>Work Phone</displayValue>  
          </workPhone> 
          <strategyUsedForTreatment> 
            <value /> 
            <displayValue>Strategy Used</displayVal ue> 
          </strategyUsedForTreatment> 
          <planAdministrationDatetime> 
            <value /> 
            <displayValue>Plans Administered Dateti me</displayValue> 
          </planAdministrationDatetime> 
          <fax> 
            <value /> 
            <displayValue>Fax</displayValue> 
          </fax> 
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          <cell> 
            <value /> 
            <displayValue>Cell Phone</displayValue>  
          </cell> 
          <physicianNotes> 
            <value /> 
            <displayValue>Physician Notes</displayV alue> 
          </physicianNotes> 
          <oncologist> 
            <value /> 
            <displayValue>Oncologist</displayValue>  
          </oncologist> 
          <country> 
            <value /> 
            <displayValue>Country</displayValue> 
          </country> 
          <caseHistory> 
            <value /> 
            <displayValue>Case History</displayValu e> 
          </caseHistory> 
          <address> 
            <value /> 
            <displayValue>Address</displayValue> 
          </address> 
          <radiologist> 
            <value /> 
            <displayValue>Radiologist</displayValue > 
          </radiologist> 
          <weightUnits> 
            <value>kg</value> 
            <displayValue>Weight Units</displayValu e> 
          </weightUnits> 
          <plansAdministered> 
            <value /> 
            <displayValue>Plans Administered</displ ayValue> 
          </plansAdministered> 
          <treatingPhysician> 
            <value /> 
            <displayValue>Treating Physician</displ ayValue> 
          </treatingPhysician> 
        </patientInfo> 
      </patientData> 
      <plans> 
        <plan id="plan"> 
          <dataID>plan</dataID> 
          <patientID>2007mar12test01</patientID> 
          <modality>External_Beam_P</modality> 
          <locked>false</locked> 
          <plan_fields> 
            <element key="field">1.0</element> 
          </plan_fields> 
        </plan> 
      </plans> 
      <strategies> 
        <strategy id="strat"> 
          <dataID>strat</dataID> 
          <patientID>2007mar12test01</patientID> 
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          <locked>false</locked> 
          <planIDSet> 
            <element>plan</element> 
          </planIDSet> 
        </strategy> 
      </strategies> 
    </patient> 
  </patients> 
</minerva> 
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APPENDIX E-XML FILE WITH SOURCE 
EXAMPLE XML FILE WITH SOURCE 
This is an example xml file of a test patient that could be used as a guide for constructing the API 
between MINERVA and the source plugin .  Elements with a bin extension would be provided by the 
exporter. 
 
 
<?xml version="1.0" encoding="UTF-8"?> 
<minerva> 
  <patients> 
    <patient id="mtr test"> 
      <geometries> 
        <geometry id="test4_geom"> 
          <patientID>mtr test</patientID> 
          <dataID>test4_geom</dataID> 
          <IS_length>8</IS_length> 
          <RL_length>8</RL_length> 
          <AP_length>8</AP_length> 
          <IS_mult>1.0</IS_mult> 
          <RL_mult>1.0</RL_mult> 
          <AP_mult>1.0</AP_mult> 
          <IS_adder>0.0</IS_adder> 
          <RL_adder>0.0</RL_adder> 
          <AP_adder>0.0</AP_adder> 
          <sliceOrientation>AXIAL</sliceOrientation > 
          <dimensionality>CM</dimensionality> 
          <creationDate>2005-10-10T10:48:37Z</creat ionDate> 
          <modificationDate>2007-03-14T14:08:51Z</m odificationDate> 
          <fiducialMarkerMap /> 
          <constraintMarkerMap /> 
          <regionConstraintMarkerMap /> 
          <convergenceMarkerMap /> 
          <body_info> 
            <bodyInfo key="0"> 
              <name>undefined</name> 
              <material_name>undefined</material_na me> 
              <uvval>0</uvval> 
              <c_red>0</c_red> 
              <c_green>0</c_green> 
              <c_blue>0</c_blue> 
              <regionID>0</regionID> 
              <IS_lowerBounds>0.0</IS_lowerBounds> 
              <IS_upperBounds>0.0</IS_upperBounds> 
              <RL_lowerBounds>0.0</RL_lowerBounds> 
              <RL_upperBounds>0.0</RL_upperBounds> 
              <AP_lowerBounds>0.0</AP_lowerBounds> 
              <AP_upperBounds>0.0</AP_upperBounds> 
            </bodyInfo> 
            <bodyInfo key="1"> 
              <name>water</name> 
              <material_name>Unassigned</material_n ame> 
              <uvval>0</uvval> 
              <c_red>-127</c_red> 
              <c_green>-26</c_green> 
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              <c_blue>-115</c_blue> 
              <regionID>1</regionID> 
              <IS_lowerBounds>0.0</IS_lowerBounds> 
              <IS_upperBounds>0.0</IS_upperBounds> 
              <RL_lowerBounds>0.0</RL_lowerBounds> 
              <RL_upperBounds>0.0</RL_upperBounds> 
              <AP_lowerBounds>0.0</AP_lowerBounds> 
              <AP_upperBounds>0.0</AP_upperBounds> 
            </bodyInfo> 
            <bodyInfo key="2"> 
              <name>ventricles</name> 
              <material_name>Unassigned</material_n ame> 
              <uvval>0</uvval> 
              <c_red>51</c_red> 
              <c_green>51</c_green> 
              <c_blue>-1</c_blue> 
              <regionID>2</regionID> 
              <IS_lowerBounds>0.0</IS_lowerBounds> 
              <IS_upperBounds>0.0</IS_upperBounds> 
              <RL_lowerBounds>0.0</RL_lowerBounds> 
              <RL_upperBounds>0.0</RL_upperBounds> 
              <AP_lowerBounds>0.0</AP_lowerBounds> 
              <AP_upperBounds>0.0</AP_upperBounds> 
            </bodyInfo> 
            <bodyInfo key="3"> 
              <name>carbohydrate</name> 
              <material_name>Unassigned</material_n ame> 
              <uvval>0</uvval> 
              <c_red>-1</c_red> 
              <c_green>51</c_green> 
              <c_blue>51</c_blue> 
              <regionID>3</regionID> 
              <IS_lowerBounds>0.0</IS_lowerBounds> 
              <IS_upperBounds>0.0</IS_upperBounds> 
              <RL_lowerBounds>0.0</RL_lowerBounds> 
              <RL_upperBounds>0.0</RL_upperBounds> 
              <AP_lowerBounds>0.0</AP_lowerBounds> 
              <AP_upperBounds>0.0</AP_upperBounds> 
            </bodyInfo> 
          </body_info> 
          <imagesets> 
            <element>test4_geom</element> 
          </imagesets> 
          <materialHash /> 
          <slices> 
            <slice>file_0.bin</slice> 
            <slice>file_1.bin</slice> 
            <slice>file_2.bin</slice> 
            <slice>file_3.bin</slice> 
            <slice>file_4.bin</slice> 
            <slice>file_5.bin</slice> 
            <slice>file_6.bin</slice> 
            <slice>file_7.bin</slice> 
          </slices> 
        </geometry> 
        <geometry id="test4_geomRot"> 
          <patientID>mtr test</patientID> 
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          <dataID>test4_geomRot</dataID> 
          <IS_length>8</IS_length> 
          <RL_length>8</RL_length> 
          <AP_length>8</AP_length> 
          <IS_mult>1.0</IS_mult> 
          <RL_mult>1.0</RL_mult> 
          <AP_mult>1.0</AP_mult> 
          <IS_adder>0.0</IS_adder> 
          <RL_adder>0.0</RL_adder> 
          <AP_adder>0.0</AP_adder> 
          <sliceOrientation>AXIAL</sliceOrientation > 
          <dimensionality>CM</dimensionality> 
          <creationDate>2005-10-10T13:10:17Z</creat ionDate> 
          <modificationDate>2007-03-14T14:08:51Z</m odificationDate> 
          <fiducialMarkerMap /> 
          <constraintMarkerMap /> 
          <regionConstraintMarkerMap /> 
          <convergenceMarkerMap /> 
          <body_info> 
            <bodyInfo key="0"> 
              <name>undefined</name> 
              <material_name>undefined</material_na me> 
              <uvval>0</uvval> 
              <c_red>0</c_red> 
              <c_green>0</c_green> 
              <c_blue>0</c_blue> 
              <regionID>0</regionID> 
              <IS_lowerBounds>0.0</IS_lowerBounds> 
              <IS_upperBounds>0.0</IS_upperBounds> 
              <RL_lowerBounds>0.0</RL_lowerBounds> 
              <RL_upperBounds>0.0</RL_upperBounds> 
              <AP_lowerBounds>0.0</AP_lowerBounds> 
              <AP_upperBounds>0.0</AP_upperBounds> 
            </bodyInfo> 
            <bodyInfo key="1"> 
              <name>water</name> 
              <material_name>Unassigned</material_n ame> 
              <uvval>0</uvval> 
              <c_red>-43</c_red> 
              <c_green>-40</c_green> 
              <c_blue>-46</c_blue> 
              <regionID>1</regionID> 
              <IS_lowerBounds>0.0</IS_lowerBounds> 
              <IS_upperBounds>0.0</IS_upperBounds> 
              <RL_lowerBounds>0.0</RL_lowerBounds> 
              <RL_upperBounds>0.0</RL_upperBounds> 
              <AP_lowerBounds>0.0</AP_lowerBounds> 
              <AP_upperBounds>0.0</AP_upperBounds> 
            </bodyInfo> 
            <bodyInfo key="2"> 
              <name>ventricles</name> 
              <material_name>Unassigned</material_n ame> 
              <uvval>0</uvval> 
              <c_red>-9</c_red> 
              <c_green>115</c_green> 
              <c_blue>-93</c_blue> 
              <regionID>2</regionID> 
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              <IS_lowerBounds>0.0</IS_lowerBounds> 
              <IS_upperBounds>0.0</IS_upperBounds> 
              <RL_lowerBounds>0.0</RL_lowerBounds> 
              <RL_upperBounds>0.0</RL_upperBounds> 
              <AP_lowerBounds>0.0</AP_lowerBounds> 
              <AP_upperBounds>0.0</AP_upperBounds> 
            </bodyInfo> 
            <bodyInfo key="3"> 
              <name>carbohydrates</name> 
              <material_name>Unassigned</material_n ame> 
              <uvval>0</uvval> 
              <c_red>49</c_red> 
              <c_green>-103</c_green> 
              <c_blue>-103</c_blue> 
              <regionID>3</regionID> 
              <IS_lowerBounds>0.0</IS_lowerBounds> 
              <IS_upperBounds>0.0</IS_upperBounds> 
              <RL_lowerBounds>0.0</RL_lowerBounds> 
              <RL_upperBounds>0.0</RL_upperBounds> 
              <AP_lowerBounds>0.0</AP_lowerBounds> 
              <AP_upperBounds>0.0</AP_upperBounds> 
            </bodyInfo> 
          </body_info> 
          <imagesets> 
            <element>test4_geomRot</element> 
          </imagesets> 
          <materialHash /> 
          <slices> 
            <slice>file_8.bin</slice> 
            <slice>file_9.bin</slice> 
            <slice>file_10.bin</slice> 
            <slice>file_11.bin</slice> 
            <slice>file_12.bin</slice> 
            <slice>file_13.bin</slice> 
            <slice>file_14.bin</slice> 
            <slice>file_15.bin</slice> 
          </slices> 
        </geometry> 
        <geometry id="test4_geomTARBlox"> 
          <patientID>mtr test</patientID> 
          <dataID>test4_geomTARBlox</dataID> 
          <IS_length>8</IS_length> 
          <RL_length>8</RL_length> 
          <AP_length>8</AP_length> 
          <IS_mult>1.0</IS_mult> 
          <RL_mult>1.0</RL_mult> 
          <AP_mult>1.0</AP_mult> 
          <IS_adder>0.0</IS_adder> 
          <RL_adder>0.0</RL_adder> 
          <AP_adder>0.0</AP_adder> 
          <sliceOrientation>AXIAL</sliceOrientation > 
          <dimensionality>CM</dimensionality> 
          <creationDate>2005-10-10T13:10:17Z</creat ionDate> 
          <modificationDate>2007-03-14T14:08:51Z</m odificationDate> 
          <fiducialMarkerMap /> 
          <constraintMarkerMap /> 
          <regionConstraintMarkerMap /> 
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          <convergenceMarkerMap /> 
          <body_info> 
            <bodyInfo key="0"> 
              <name>undefined</name> 
              <material_name>undefined</material_na me> 
              <uvval>0</uvval> 
              <c_red>0</c_red> 
              <c_green>0</c_green> 
              <c_blue>0</c_blue> 
              <regionID>0</regionID> 
              <IS_lowerBounds>0.0</IS_lowerBounds> 
              <IS_upperBounds>0.0</IS_upperBounds> 
              <RL_lowerBounds>0.0</RL_lowerBounds> 
              <RL_upperBounds>0.0</RL_upperBounds> 
              <AP_lowerBounds>0.0</AP_lowerBounds> 
              <AP_upperBounds>0.0</AP_upperBounds> 
            </bodyInfo> 
            <bodyInfo key="1"> 
              <name>water</name> 
              <material_name>Unassigned</material_n ame> 
              <uvval>0</uvval> 
              <c_red>-43</c_red> 
              <c_green>-40</c_green> 
              <c_blue>-46</c_blue> 
              <regionID>1</regionID> 
              <IS_lowerBounds>0.0</IS_lowerBounds> 
              <IS_upperBounds>0.0</IS_upperBounds> 
              <RL_lowerBounds>0.0</RL_lowerBounds> 
              <RL_upperBounds>0.0</RL_upperBounds> 
              <AP_lowerBounds>0.0</AP_lowerBounds> 
              <AP_upperBounds>0.0</AP_upperBounds> 
            </bodyInfo> 
            <bodyInfo key="2"> 
              <name>ventricles</name> 
              <material_name>Unassigned</material_n ame> 
              <uvval>0</uvval> 
              <c_red>-9</c_red> 
              <c_green>115</c_green> 
              <c_blue>-93</c_blue> 
              <regionID>2</regionID> 
              <IS_lowerBounds>0.0</IS_lowerBounds> 
              <IS_upperBounds>0.0</IS_upperBounds> 
              <RL_lowerBounds>0.0</RL_lowerBounds> 
              <RL_upperBounds>0.0</RL_upperBounds> 
              <AP_lowerBounds>0.0</AP_lowerBounds> 
              <AP_upperBounds>0.0</AP_upperBounds> 
            </bodyInfo> 
            <bodyInfo key="3"> 
              <name>carbohydrates</name> 
              <material_name>Unassigned</material_n ame> 
              <uvval>0</uvval> 
              <c_red>49</c_red> 
              <c_green>-103</c_green> 
              <c_blue>-103</c_blue> 
              <regionID>3</regionID> 
              <IS_lowerBounds>0.0</IS_lowerBounds> 
              <IS_upperBounds>0.0</IS_upperBounds> 
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              <RL_lowerBounds>0.0</RL_lowerBounds> 
              <RL_upperBounds>0.0</RL_upperBounds> 
              <AP_lowerBounds>0.0</AP_lowerBounds> 
              <AP_upperBounds>0.0</AP_upperBounds> 
            </bodyInfo> 
            <bodyInfo key="4"> 
              <name>TopAnteriorRightBlob</name> 
              <material_name>Unassigned</material_n ame> 
              <uvval>0</uvval> 
              <c_red>-61</c_red> 
              <c_green>28</c_green> 
              <c_blue>-63</c_blue> 
              <regionID>4</regionID> 
              <IS_lowerBounds>0.0</IS_lowerBounds> 
              <IS_upperBounds>0.0</IS_upperBounds> 
              <RL_lowerBounds>0.0</RL_lowerBounds> 
              <RL_upperBounds>0.0</RL_upperBounds> 
              <AP_lowerBounds>0.0</AP_lowerBounds> 
              <AP_upperBounds>0.0</AP_upperBounds> 
            </bodyInfo> 
          </body_info> 
          <imagesets> 
            <element>test4_geomRot</element> 
          </imagesets> 
          <materialHash /> 
          <slices> 
            <slice>file_16.bin</slice> 
            <slice>file_17.bin</slice> 
            <slice>file_18.bin</slice> 
            <slice>file_19.bin</slice> 
            <slice>file_20.bin</slice> 
            <slice>file_21.bin</slice> 
            <slice>file_22.bin</slice> 
            <slice>file_23.bin</slice> 
          </slices> 
        </geometry> 
      </geometries> 
      <fields> 
        <field id="TAR test"> 
          <patientID>mtr test</patientID> 
          <dataID>TAR test</dataID> 
          <sourceID>TAR test</sourceID> 
          <geometryID>test4_geomTARBlox</geometryID > 
          <description_string /> 
          <modality>MTR</modality> 
          <sourcePluginName>MTR source</sourcePlugi nName> 
          <transportPluginName>Default Transport</t ransportPluginName> 
          <doseID /> 
          
<sourceClassString>minerva.tirade.common.data.Singl eActivityMap</sourceClassS
tring> 
          <locked>false</locked> 
          <sourceProperties> 
            <element key="detector_efficiency">1.0< /element> 
            <element key="width_direction_1">[-0.0, -1.0,-0.0]</element> 
            <element key="detector_area">1.11E-5</e lement> 
            <element key="height_spacing_1">0.33333 33333333333</element> 
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            <element key="height_spacing_0">0.33333 33333333333</element> 
            <element key="calc_valid_1">false</elem ent> 
            <element key="calc_valid_0">false</elem ent> 
            <element key="width_direction_0">[0.0,1 .0,0.0]</element> 
            <element key="posterior_image_index">1< /element> 
            <element key="activity_set">false</elem ent> 
            <element key="distance">-0.5</element> 
            <element key="width_spacing_0">0.333333 3333333333</element> 
            <element key="image_name">test5_emmissi on</element> 
            <element key="bodies_0">1,4</element> 
            <element key="width_spacing_1">0.333333 3333333333</element> 
            <element key="bodies_1">1,4</element> 
            <element key="image_width_flip">1</elem ent> 
            <element key="height_dimension_0">24</e lement> 
            <element key="counts_per_micro_curie">8 .018333333333334</element> 
            <element key="width_dimension_0">24</el ement> 
            <element key="width_dimension_1">24</el ement> 
            <element key="image_height_flip">1</ele ment> 
            <element key="view_direction_1">5</elem ent> 
            <element key="view_direction_0">4</elem ent> 
            <element key="imaging_nuclide">I-131</e lement> 
            <element key="use_counts_per">false</el ement> 
            <element key="height_dimension_1">24</e lement> 
            <element key="height_direction_1">[-0.0 ,-0.0,-1.0]</element> 
            <element key="projection_direction_1">[ -1.0,-0.0,-0.0]</element> 
            <element key="height_direction_0">[-0.0 ,-0.0,-1.0]</element> 
            <element key="projection_direction_0">[ 1.0,0.0,0.0]</element> 
            <element key="current_view">0</element>  
            <element key="anterior_image_index">0</ element> 
            <element key="background">false</elemen t> 
            <element key="image_corner_1">[7.5,7.5, 7.5]</element> 
            <element key="image_corner_0">[-0.5,-0. 5,7.5]</element> 
            <element key="calc_made_0">false</eleme nt> 
            <element key="treatment_nuclide">I-131< /element> 
            <element key="calc_made_1">false</eleme nt> 
          </sourceProperties> 
          <transportProperties /> 
        </field> 
        <field id="correct_geom2"> 
          <patientID>mtr test</patientID> 
          <dataID>correct_geom2</dataID> 
          <sourceID>correct_geom2</sourceID> 
          <geometryID>test4_geomRot</geometryID> 
          <description_string /> 
          <modality>MTR</modality> 
          <sourcePluginName>MTR source</sourcePlugi nName> 
          <transportPluginName>Default Transport</t ransportPluginName> 
          <doseID /> 
          
<sourceClassString>minerva.tirade.common.data.Singl eActivityMap</sourceClassS
tring> 
          <locked>false</locked> 
          <sourceProperties> 
            <element key="detector_efficiency">1.0< /element> 
            <element key="width_direction_1">[0.0,1 .0,0.0]</element> 
            <element key="detector_area">1.11E-5</e lement> 
            <element key="height_spacing_1">0.33333 33333333333</element> 
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            <element key="height_spacing_0">0.33333 33333333333</element> 
            <element key="calc_valid_1">false</elem ent> 
            <element key="calc_valid_0">false</elem ent> 
            <element key="width_direction_0">[-0.0, -1.0,-0.0]</element> 
            <element key="posterior_image_index">1< /element> 
            <element key="activity_set">false</elem ent> 
            <element key="distance">0.0</element> 
            <element key="width_spacing_0">0.333333 3333333333</element> 
            <element key="image_name">test5_emmissi on</element> 
            <element key="bodies_0" /> 
            <element key="width_spacing_1">0.333333 3333333333</element> 
            <element key="bodies_1" /> 
            <element key="image_width_flip">1</elem ent> 
            <element key="height_dimension_0">24</e lement> 
            <element 
key="counts_per_micro_curie">2.8333333333333335</el ement> 
            <element key="width_dimension_0">24</el ement> 
            <element key="width_dimension_1">24</el ement> 
            <element key="image_height_flip">1</ele ment> 
            <element key="view_direction_1">5</elem ent> 
            <element key="view_direction_0">4</elem ent> 
            <element key="imaging_nuclide">I-131</e lement> 
            <element key="use_counts_per">false</el ement> 
            <element key="height_dimension_1">24</e lement> 
            <element key="height_direction_1">[-0.0 ,-0.0,-1.0]</element> 
            <element key="projection_direction_1">[ -1.0,-0.0,-0.0]</element> 
            <element key="height_direction_0">[-0.0 ,-0.0,-1.0]</element> 
            <element key="projection_direction_0">[ 1.0,0.0,0.0]</element> 
            <element key="current_view">0</element>  
            <element key="anterior_image_index">0</ element> 
            <element key="background">false</elemen t> 
            <element key="image_corner_1">[7.5,-0.5 ,7.5]</element> 
            <element key="image_corner_0">[-0.5,7.5 ,7.5]</element> 
            <element key="calc_made_0">false</eleme nt> 
            <element key="treatment_nuclide">I-131< /element> 
            <element key="calc_made_1">false</eleme nt> 
          </sourceProperties> 
          <transportProperties /> 
        </field> 
        <field id="mtr_test"> 
          <patientID>mtr test</patientID> 
          <dataID>mtr_test</dataID> 
          <sourceID /> 
          <geometryID>test4_geom</geometryID> 
          <description_string /> 
          <modality>MTR</modality> 
          <sourcePluginName>MTR source</sourcePlugi nName> 
          <transportPluginName>Default Transport</t ransportPluginName> 
          <doseID /> 
          <sourceClassString /> 
          <locked>false</locked> 
          <sourceProperties /> 
          <transportProperties /> 
        </field> 
        <field id="test 4"> 
          <patientID>mtr test</patientID> 
          <dataID>test 4</dataID> 
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          <sourceID /> 
          <geometryID>test4_geom</geometryID> 
          <description_string /> 
          <modality>External_Beam_N</modality> 
          <sourcePluginName>Test Source</sourcePlug inName> 
          <transportPluginName>Default Transport</t ransportPluginName> 
          <doseID /> 
          <sourceClassString /> 
          <locked>false</locked> 
          <sourceProperties /> 
          <transportProperties /> 
        </field> 
        <field id="test_2"> 
          <patientID>mtr test</patientID> 
          <dataID>test_2</dataID> 
          <sourceID /> 
          <geometryID>test4_geom</geometryID> 
          <description_string /> 
          <modality>MTR</modality> 
          <sourcePluginName>MTR source</sourcePlugi nName> 
          <transportPluginName>Default Transport</t ransportPluginName> 
          <doseID /> 
          <sourceClassString /> 
          <locked>false</locked> 
          <sourceProperties /> 
          <transportProperties /> 
        </field> 
        <field id="test_3"> 
          <patientID>mtr test</patientID> 
          <dataID>test_3</dataID> 
          <sourceID /> 
          <geometryID>test4_geom</geometryID> 
          <description_string /> 
          <modality>MTR2</modality> 
          <sourcePluginName>Test Source</sourcePlug inName> 
          <transportPluginName /> 
          <doseID /> 
          <sourceClassString /> 
          <locked>false</locked> 
          <sourceProperties /> 
          <transportProperties /> 
        </field> 
      </fields> 
      <patientData> 
        <dataID>mtr test</dataID> 
        <patientID>mtr test</patientID> 
        <physicianNotes /> 
        <patientInfo> 
          <homeEmail> 
            <value /> 
            <displayValue>Home Email</displayValue>  
          </homeEmail> 
          <sex> 
            <value /> 
            <displayValue>Sex</displayValue> 
          </sex> 
          <weight> 
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            <value /> 
            <displayValue>Weight</displayValue> 
          </weight> 
          <state> 
            <value /> 
            <displayValue>State</displayValue> 
          </state> 
          <referringPhysician> 
            <value /> 
            <displayValue>Referring Physician</disp layValue> 
          </referringPhysician> 
          <patientIDKey> 
            <value /> 
            <displayValue>Patient ID</displayValue>  
          </patientIDKey> 
          <diagnosis> 
            <value /> 
            <displayValue>Diagnosis</displayValue> 
          </diagnosis> 
          <emergencyContactInfo> 
            <value /> 
            <displayValue>Emergency Contact Info</d isplayValue> 
          </emergencyContactInfo> 
          <homePhone> 
            <value /> 
            <displayValue>Home Phone</displayValue>  
          </homePhone> 
          <city> 
            <value /> 
            <displayValue>City</displayValue> 
          </city> 
          <treatmentProtocolID> 
            <value /> 
            <displayValue>Treatment Protocol ID</di splayValue> 
          </treatmentProtocolID> 
          <workEmail> 
            <value /> 
            <displayValue>Work Email</displayValue>  
          </workEmail> 
          <height> 
            <value /> 
            <displayValue>Height</displayValue> 
          </height> 
          <patientName> 
            <value>MTR Test</value> 
            <displayValue>Patient Name</displayValu e> 
          </patientName> 
          <postalCode> 
            <value /> 
            <displayValue>Zip</displayValue> 
          </postalCode> 
          <age> 
            <value /> 
            <displayValue>Age</displayValue> 
          </age> 
          <heightUnits> 
            <value>meters</value> 
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            <displayValue>Height Units</displayValu e> 
          </heightUnits> 
          <birthdate> 
            <value>Mon Oct 10 10:42:18 MDT 2005</va lue> 
            <displayValue>Birthdate</displayValue> 
          </birthdate> 
          <workPhone> 
            <value /> 
            <displayValue>Work Phone</displayValue>  
          </workPhone> 
          <strategyUsedForTreatment> 
            <value /> 
            <displayValue>Strategy Used</displayVal ue> 
          </strategyUsedForTreatment> 
          <planAdministrationDatetime> 
            <value /> 
            <displayValue>Plans Administered Dateti me</displayValue> 
          </planAdministrationDatetime> 
          <fax> 
            <value /> 
            <displayValue>Fax</displayValue> 
          </fax> 
          <cell> 
            <value /> 
            <displayValue>Cell Phone</displayValue>  
          </cell> 
          <physicianNotes> 
            <value /> 
            <displayValue>Physician Notes</displayV alue> 
          </physicianNotes> 
          <oncologist> 
            <value /> 
            <displayValue>Oncologist</displayValue>  
          </oncologist> 
          <country> 
            <value /> 
            <displayValue>Country</displayValue> 
          </country> 
          <caseHistory> 
            <value /> 
            <displayValue>Case History</displayValu e> 
          </caseHistory> 
          <address> 
            <value /> 
            <displayValue>Address</displayValue> 
          </address> 
          <radiologist> 
            <value /> 
            <displayValue>Radiologist</displayValue > 
          </radiologist> 
          <plansAdministered> 
            <value /> 
            <displayValue>Plans Administered</displ ayValue> 
          </plansAdministered> 
          <weightUnits> 
            <value>kg</value> 
            <displayValue>Weight Units</displayValu e> 
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          </weightUnits> 
          <treatingPhysician> 
            <value /> 
            <displayValue>Treating Physician</displ ayValue> 
          </treatingPhysician> 
        </patientInfo> 
      </patientData> 
      <plans> 
        <plan id="external_test"> 
          <dataID>external_test</dataID> 
          <patientID>mtr test</patientID> 
          <modality>External_Beam_N</modality> 
          <locked>false</locked> 
          <plan_fields> 
            <element key="test 4">1.0</element> 
          </plan_fields> 
        </plan> 
        <plan id="mtr2_test"> 
          <dataID>mtr2_test</dataID> 
          <patientID>mtr test</patientID> 
          <modality>MTR2</modality> 
          <locked>false</locked> 
          <plan_fields> 
            <element key="test_3">1.0</element> 
          </plan_fields> 
        </plan> 
        <plan id="mtr_test"> 
          <dataID>mtr_test</dataID> 
          <patientID>mtr test</patientID> 
          <modality>MTR</modality> 
          <locked>false</locked> 
          <plan_fields> 
            <element key="correct_geom2">1.0</eleme nt> 
            <element key="test_2">0.0</element> 
            <element key="mtr_test">0.0</element> 
            <element key="TAR test">0.0</element> 
          </plan_fields> 
        </plan> 
      </plans> 
    </patient> 
  </patients> 
</minerva> 


